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Net Nanny’s Chat Monitor User’s Guide 
The software described in this guide is furnished under a license agreement and may be use only in accordance with the terms of the 
agreement. 
 
Last updated on: November 19, 2004 
Documentation version: 2.2 
 
Disclaimer 
LookSmart, Ltd. does not claim that Net Nanny software will make the use of your computer, the Internet, or any other online service safe 
for you or other individuals. This software is a tool to help you take responsibility for making your own personal decisions about freedom 
of speech and Internet safety.  
 
Copyright Notice 
Copyright ©2004 LookSmart, Ltd.. All Rights Reserved. 
 
Any documentation that is made available by LookSmart, Ltd. is the copyrighted work of LookSmart, Ltd. and is owned by LookSmart, 
Ltd.. 
 
NO WARRANTY. The documentation is being delivered to you AS IS and LookSmart, Ltd. makes no warranty as to its accuracy or user. 
Any use of the documentation or the information contained therein is at the risk of the user. Documentation may include technical or 
other inaccuracies or typographical errors. LookSmart, Ltd. reserves the right to make changes without prior notice. 
 
No part of this publication may be copied without the express written permission of LookSmart, Ltd., 625 2nd Street, San Francisco, CA 
94107. 
 
Trademarks 
Net Nanny® and the Net Nanny logo are trademarks of LookSmart, Ltd.. Windows is a registered trademark of Microsoft Corporation. 
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PLEASE READ THIS AGREEMENT CAREFULLY 

 
LICENSE AGREEMENT 

LookSmart, Ltd. (“LookSmart”) is willing to grant you (“Licensee”) the following license to use the Net Nanny software (the “Software”) 
according to this Agreement only on the condition that Licensee accepts all terms in this Agreement. 

BY CLICKING ON THE “I ACCEPT” BUTTON BELOW, LICENSEE ACKNOWLEDGES THAT LICENSEE HAS READ THIS 

AGREEMENT, UNDERSTANDS IT, AND AGREES TO BE BOUND BY IT.  IF LICENSEE DOES NOT AGREE TO ANY OF THE TERMS 

BELOW, LOOKSMART IS UNWILLING TO LICENSE THE SOFTWARE TO LICENSEE, AND LICENSEE SHOULD CLICK ON THE “I DO 

NOT ACCEPT” BUTTON BELOW. 
 

1. License.  Subject to the terms of this Agreement, LookSmart hereby grants to Licensee a non-exclusive, limited, non-
transferable license to use the Software in machine-readable form on a single computer as long as this Agreement is in effect.  
Notwithstanding the foregoing, if Licensee has obtained an evaluation copy of the Software and has not purchased a license, LookSmart 
grants to Licensee a non-exclusive, limited, non-transferable license to use the Software in machine-readable form for a thirty (30)-day 
period for the purpose of evaluating whether Licensee wishes to purchase a license for the Software. WARNING: Evaluation copies of the 
Software will become non-functional thirty (30) days following initial installation. 

2. Restrictions.  LookSmart and its suppliers retain all right, title and interest in and to the Software, and any rights not expressly 
granted to Licensee herein are reserved by LookSmart and its suppliers.  Licensee may not copy, distribute, sublicense, rent, lease, loan, 
modify or create derivative works, adapt, translate, sublicense or transfer the Software.  Licensee acknowledges that the Software and its 
structure, organization, and source code constitute valuable trade secrets of LookSmart and its suppliers.  Licensee may not reverse 
engineer, disassemble, or decompile the Software except to the extent that this restriction is expressly prohibited by applicable law.  
Licensee may not remove from any part of the Software any notice of proprietary rights or any disclaimer.   

3. Warranty.  If Licensee has purchased a license to the Software, and the Software is delivered using a storage media such as a 
CD-ROM, LookSmart warrants that the media on which the Software is furnished will be free from defects in materials and workmanship 
for thirty (30) days from the date Licensee received the Software, as shown by Licensee’s receipt. This warranty is limited to Licensee and is 
not transferable. This warranty does not cover damage caused by improper use or neglect.  LookSmart’s sole and exclusive liability and 
Licensee’s sole and exclusive remedy under this warranty shall be for LookSmart to replace the defective media.  Licensee expressly 
acknowledges and agrees that, aside from the media warranty contained in this section, the Software is provided "AS IS" without any 
warranties or conditions whatsoever.  Without limiting the foregoing, you acknowledge that no software program, including the Software, 
will be 100% effective at screening out offensive or unwanted content, and that LookSmart does not make any warranty that the Software 
will screen out all offensive or unwanted content.  LOOKSMART AND ITS SUPPLIERS DISCLAIM ALL OTHER WARRANTIES 
AND CONDITIONS, EXPRESS, IMPLIED OR STATUTORY, INCLUDING WITHOUT LIMITATION THE IMPLIED 
WARRANTIES OF TITLE, NON-INFRINGEMENT, MERCHANTABILITY, AND FITNESS FOR A PARTICULAR PURPOSE, 
OR THAT THE OPERATION OF THE SOFTWARE WILL PRODUCE CERTAIN RESULTS, BE UNINTERRUPTED OR 
ERROR-FREE, OR THAT ALL ERRORS WILL BE CORRECTED.  Because some jurisdictions do not permit the exclusion of implied 
warranties, this disclaimer may not apply to Licensee.   

4. Limitation of Liability.  REGARDLESS OF WHETHER ANY REMEDY SET FORTH HEREIN FAILS OF ITS 
ESSENTIAL PURPOSE OR OTHERWISE, IN NO EVENT SHALL LOOKSMART OR ITS SUPPLIERS BE LIABLE TO 
LICENSEE OR ANY THIRD PARTY FOR (I) LOSS, INJURY OR DAMAGE CAUSED IN WHOLE OR PART BY USE OF, OR 
FAILURES, DELAYS OR INTERRUPTIONS OF, THE SOFTWARE, OR (II) ANY INDIRECT, CONSEQUENTIAL, 
INCIDENTAL OR SPECIAL DAMAGES, INCLUDING BUT NOT LIMITED TO ANY LOST PROFITS ARISING OUT OF OR 
RELATING TO THE USE OR INABILITY TO USE THE SOFTWARE EVEN IF ADVISED OF THE POSSIBILITY OF SUCH 
DAMAGES.  LookSmart’s total cumulative liability in connection with this Agreement and the Software, whether in contract or tort or 
otherwise, will not exceed the license fee paid by Licensee to LOOKSMART for the license to the Software.  Licensee acknowledges that 
the license fee reflects the allocation of risk set forth in this Agreement and that LookSmart would not enter into this Agreement without 
these limitations on its liability.  SOME JURISDICTIONS DO NOT ALLOW THE EXCLUSION OR LIMITATION OF 
WARRANTIES OR INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THE ABOVE LIMITATIONS OR EXCLUSIONS 
MAY NOT APPLY TO LICENSEE.   

5. Term; Termination.  This Agreement shall terminate automatically upon Licensee’s breach of any term of this Agreement.  If 
Licensee has obtained an evaluation copy of the Software and does not purchase a license prior to expiration of the trial period, this 
Agreement shall terminate thirty (30) days following initial installation of the Software on Licensee’s computer.  Upon termination of this 
Agreement for any reason, all license rights granted in this Agreement will immediately cease to exist, and Licensee shall destroy its copy of 
the Software.  Sections 2, 3, 4, 5, 6, 7, and 8 will survive any termination of this Agreement. 

6. Export.  The Software may be subject to U.S. export control laws or import/export regulations in other countries.  Licensee 
agrees to comply strictly with all such laws and regulations and acknowledges that Licensee has the responsibility to obtain such licenses to 
export, re-export, or import as may be required.  Licensee will indemnify and hold LookSmart and its suppliers harmless from any and all 
claims, losses, liabilities, damages, fines, penalties, costs and expenses (including attorney’s fees) arising from or relating to any breach by 
Licensee of its obligations under this section.   

7. Government End Users.  The Software is comprised of “commercial computer software” and “commercial computer 
software documentation” as such terms are used in 48 C.F.R. 12.212 (SEPT 1995) and is provided to the Government (i) for acquisition by 
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or on behalf of civilian agencies, consistent with the policy set forth in 48 C.F.R. 12.212; or (ii) for acquisition by or on behalf of units of 
the Department of Defense, consistent with the policies set forth in 48 C.F.R. 227-7202-1 (JUN 1995) and 227.7202-3 (JUN 1995). 

8. General.  This Agreement is governed and interpreted in accordance with the laws of the State of California without giving 
effect to its conflict of laws provisions.  Both parties submit to jurisdiction in California and further agree that any cause of action arising 
under this Agreement must be brought in a court in San Francisco County, California.  The UN Convention on Contracts for the 
International Sale of Goods is expressly disclaimed.  If any provision herein is held to be invalid or unenforceable for any reason, the 
remaining provisions will continue in full force without being impaired or invalidated in any way.  The parties agree to replace any invalid 
provision with a valid provision that most closely approximates the intent and economic effect of the invalid provision.  Headings are for 
reference purposes only and in no way define, limit, construe or describe the scope or extent of such section.  The waiver of a breach of 
any provision of this Agreement will not operate or be interpreted as a waiver of any other or subsequent breach.  This Agreement is the 
entire and exclusive agreement, and supersedes all prior agreements (whether written or oral) and other communications, between 
LookSmart and Licensee with respect to the Software.    
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1 
About Net Nanny’s Chat Monitor 
Safety Software for Chatting Online 

Net Nanny®'s Chat Monitor™ discretely monitors and records popular chat and instant messaging programs, notifies 
parents when their child is in a potentially risky conversation, limits time spent online chatting, and enables parents to 
secure identity-related information such as names, phone numbers, bank account and credit card numbers. 
 
Features and Benefits 
Know exactly what your kids are saying online  

 Records both sides of popular chat and instant messaging conversations. Children are chatting 
with individuals that parents do not know and cannot identify.  Chat Monitor records the date, time, 
online names, and the full text of chat conversations.  These recordings can be sent to parents by email 
as well as reviewed directly from the database on the computer where Chat Monitor is installed.  

 Sends activity reports to you by email, as often as every hour. Chat Monitor lets you know what 
your children are doing, even when you are not at home. Parents can be notified hourly or just once a 
day by email with a summary report of chat activity for each Windows user including individual 
recordings of conversations.   

 Monitors in stealth mode. Chat Monitor can be installed so that it is practically invisible on your 
computer. Choosing a stealth installation means that the program will be installed and will not appear 
on the Start menu, in the system tray, Windows task manager, or in the Add/Remove programs list. 

Reduce risk of exposure to online predators  

 Prevents your child from giving out personal, identifying information and records any attempts 
to do so. Children feel safe online and often have no qualms about giving out identifying information. 
Chat Monitor lets parents customize what information they want to protect and notifies them when 
their child attempts to give out that information. It also keeps a record of all incidents where children 
attempt to give out personal information, even if Chat Monitor filters it. 

 Displays customizable on-screen warnings message from you to your children when possible 
threatening conversations arise. Technology is only a tool for parents to use in keeping children safe 
on the Internet, and every parent has different values and beliefs regarding Internet usage. Chat Monitor 
can display personalized messages from parents to remind their child of their family's values and 
concerns about online safety.  

 Immediate email alert sent to you if children receive certain "solicitous" messages in a chat, 
such as, "do you like boys?" or "what r u wearing?" Children often are engaged in conversations that 
parents find suspicious or indicative of a potential threat. Chat Monitor enables parents to decide what 
content within a conversation is potentially risky and notifies them in real-time when the risk is 
perceived as high.  

 Automatic termination of the chat or instant messenger conversation when a threshold has 
been reached involving children receiving solicitous messages. Chat Monitor provides several 
options from which parents can choose for worrisome situations.  

1 
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Control time spent chatting 

 Disables access to popular chat and instant messaging programs. Chat Monitor limits access based 
on your selections, ranging from no access to chat and messenger programs to full access. 

 Schedules daily and weekly "chat free" time periods. Children are using chat services at 
unsupervised hours when parents are not at home or late at night when parents are asleep. Chat 
Monitor enables parents to decide the days of the week and hours of the day they want their child 
chatting online.  

 Records all attempts to use chat and instant messenger programs when chatting is restricted.  

Secure the software from tampering 

 Settings are password-protected. Chat Monitor requires a password to ensure that users do not 
make unwanted changes to the program's settings. 

 Robust anti-tampering measures stop kids intent on circumventing the software. Whether users 
attempt to delete the software or circumvent the time schedule, Chat Monitor includes features that 
thwart these activities and inform you of the attempts.  

Easy to use and customizable 

 Install and set up in only minutes. Chat Monitor includes a setup wizard that guides you through the 
basic configuration and gets you up and running quickly. 

 Pre-set features can be easily customized to meet your unique needs. Chat Monitor installs by 
default as "monitor-only" so that it records chat conversations and prepares and emails activity reports 
to you. From this foundation, parents can add time limit restrictions, personalize messages to users, 
customize responses to their child's actions while chatting, and more. 

 Works with popular chat and instant messaging programs. AOL Instant Messenger (AIM) and 
MSN Messengers are the two most used instant messengers. Chat Monitor works with these and many 
others: MSN Instant Messenger, Windows Messenger, Yahoo! Instant Messenger, Yahoo! Web 
Messenger, AIM, AIM Express, ICQ IM Pro 2003a, ICQ Lite, and ICQ2GO.  

 Children and young adults, more than other age groups, engage in chat rooms. Chat Monitor works with the 
following chat programs:  MSN Chat, Yahoo! Chat, AOL Chat and IRC chat programs mIRC and PIRCH. 
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2 
Installing Chat Monitor 
Installation and configuration takes only a few minutes 

System requirements 
Operating 
systems: 

Windows XP Home, Windows XP Professional, Windows 2000 Professional, Windows Me, 
Windows 98 Second Edition 

Hardware: Pentium, Pentium II, Pentium III, Pentium 4, Celeron or AMD Athlon (K6/2 or higher) 
processors 

Memory: Minimum of 32 MB of RAM 
Disk space: Minimum of 10 MB 
 
Before Installation 
You will need to decide between 2 types of installations: 
 

 Visible Installation. Choosing a visible installation means that the program is installed and appears on 
the Start menu and an icon for the program appears in the system tray on the Windows desktop. The 
program’s settings are accessible with a password. 

 Stealth Installation. Choosing a stealth installation means that the program will be installed and will 
not appear on the Start menu, in the system tray, Windows task manager, or in the Add/Remove 
programs list. The program’s settings are accessible using a keyboard hotkey combination that you 
specify, followed by a password. 

 
Important: If you decide at a later time to switch to the other type of installation, you must uninstall the software and 
reinstall it. 
 
What is a hotkey combination? A hotkey combination is a key combination on your computer’s keyboard that when 
pressed, provides access to the settings for Chat Monitor. The hotkey is available when you install the software in 
stealth mode. It helps Chat Monitor maintain an unobtrusive presence on your computer. 
 
The Importance of Providing an Email Address for Chat Monitor Reporting 
When you configure the software, you will be prompted twice to provide a current email address. Once for registering 
your software and once again later in the configuration process for receiving activity reports from Chat Monitor. The 
address you provide for receiving reports is used ONLY to send you summary reports of chat activity, real-time email 
alerts when a child is in a potentially dangerous online situation, and a record of your security information. The security 
information you can receive by email for your safekeeping is a record of your password for the software, the 
authentication questions you choose to be prompted with in case you forget your password, and if you select a stealth 
installation, the hotkey combination you define for yourself. 
 
Important: When prompted to test your email address during installation, please do so and confirm that you actually 
received an email message from Chat Monitor. 
 

3 
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What is SMTP and why do I need to provide information about a SMTP server? 
Short for Simple Mail Transfer Protocol, a protocol for sending e-mail messages between computers (servers). Most e-mail 
systems that send mail over the Internet use SMTP to send messages from one server to another. When you are 
installing Chat Monitor,  you will be prompted to specify the SMTP server name or address for your email provider, by 
choosing it from a list. The SMTP server is the name of the computer that delivers your email to you. If your provider 
is not on the list provided, you will need to contact your email provider to get the information and then type it into 
Chat Monitor. 
 
Steps to Install 
 
Important: The installation finishes with a restart of your computer. Depending on what software is installed on your 
computer, more than one restart may be necessary. 
 

1. Verify your computer meets the system requirements. 
2. Turn off anti-virus software and any other running programs before running the Chat Monitor installation 

setup 
3. If you have firewall software that blocks applications from communicating from your PC to the Internet, 

you will need to configure the firewall to allow ctmn.exe and mcfgsys.exe. 
4. Insert the CD in the CD-ROM drive of your computer. If you acquired Chat Monitor from a digital 

download, locate the icon of the file you downloaded on your desktop or in a My Computer sub-folder. 
5. Do one of the following: 

 If the Chat Monitor installer begins to run automatically, continue to Step 4. 
 If the Chat Monitor installer does not launch automatically, double-click the Setup.exe located on 

your CD-ROM or double-click the file you located in Step 2. 
6. Carefully read each screen and follow the instructions.  
7. When prompted to do so, print the Readme file. 
8. At the end of the installation, optionally check for any software updates. This is strongly recommended 

to ensure you have the latest available version of the software. 
 
Steps to Uninstall 
 
Important: The removal of the software finishes with a restart of your computer. 
 

1. Open the Chat Monitor Settings: 
 If you have a visible installation, choose Chat Monitor Settings from the Start menu. 
 If you have a stealth installation, use your hotkey combination on the Windows desktop. 

2. When prompted, type your password. 
3. On the Chat Monitor Settings window, click the Uninstall button. 
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Default Settings 
Features turned on automatically during installation: Turn these features on yourself after installation: 

 Allows all users access to all chat and IM 
programs 24 hours a day, 7 days a week 

 Records all conversations 
 Creates a summary report of chat activity 
 Records all system activity related to 

chatting 
 Email summary sent to you if you 

specified an email address 
 Individual recordings sent to you by email 
 Synchronization between the PC clock and 

an Internet atomic clock. 
 

 Filtering of content within a conversation  
 Scheduled access to chat and IM programs 

by day of the week and time of day. 
 

 
Accessing Chat Monitor Settings 
After successfully installing the software, you can now access the Chat Monitor Settings, where you can personalize the 
software to best meet your needs. 
 

To access Chat Monitor Settings: Visible installation 

1. From the system tray, locate the Chat Monitor 
icon  and click it to display the menu. 

2. Choose Edit Program Settings. 
3. When prompted, type in your password. 

  

To access Chat Monitor Settings: Stealth installation 

1. On your keyboard, press Ctrl + Shift, and 
then press your personal character (number or 
letter). 

2. When prompted, type in your password. 
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Monitoring Conversations 
Individual Recordings 

When you install Chat Monitor, the  software is pre-configured to allow access to all chat and instant messengers 
monitored by the software and to record all conversations that occur. If this meets the needs of you and your family, 
you do not need to make any additional choices in configuring the software.  
 
You can enable or disable the recording of conversations quickly and easily from the main Chat Monitor Settings 
window. 
 
Stop or start recording all chat activity 

1. Open the Chat Monitor Settings. 
2. On the main window, select either 

the On or the Off option for 
recording all chat activity. 

3. Close the settings window. 

 
 
Viewing and Printing Recordings 
Recordings can be viewed in two ways. First, they can be opened and viewed through the Chat Monitor Settings 
window on the PC where Chat Monitor is installed. The individual recordings are summarized in the Summary Report. 
You can select a recording of interest and choose to view it. It then displays in Windows® Notepad. You can print the 
recording by choosing Print the File Menu of Notepad. 
 
Important: Be sure that Word Wrap is enabled for Notepad as this makes the information easier to read. To enable 
Word Wrap, select it from the Format menu in Notepad. A check mark appears on the menu when Word Wrap is 
enabled. 
 
The second way individual records can be viewed is remotely via email. If you have chosen to have a recording sent to 
you as a file attachment, you can open it and view it on any computer capable of viewing text files. This might be at 
your workplace or at some other location. 
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To view a recording 
1. Open the Chat Monitor Settings. 
2. On the main window, select Chat 

Sessions Log from the list in the 
top left corner of the window. 

3. From the table, select a specific 
recording. 

4. Click View. 
5. Optionally print the recording. 
6. Choose Print from the File menu 

in Notepad. 
 
 
 
Storing and Deleting Recordings 
You can store individual recordings for as long as 999 days each. The default length of time is 180 days. It is 
recommended that you delete old recordings at regular intervals as dictated by the amount of space you want to use on 
the hard disk of the computer where Chat Monitor is installed. If you prefer to not have Chat Monitor delete 
recordings automatically, you can delete one or all recordings at any time. 
 
To choose when to delete recordings 

1. Open the Chat Monitor Settings. 
2. On the main window, select Chat 

Sessions Log from the list in the 
top left corner of the window. 

3. Type a value between 1 and 999 
in the box for deleting recordings. 

 
To manually delete recordings 

1. Open the Chat Monitor Settings. 
2. On the main window, select Chat 

Sessions Log from the list in the 
top left corner. 

3. Do one of the following: 
 Select a row in the table and 

then click Delete. 
 Click Delete All. 
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Searching Recordings 
You may be interested in identifying trends in chat and instant messaging conversations for a particular user or all users 
of your PC. Chat Monitor’s search function enables you to search for information in multiple recordings.  
 
To search the recordings 

1. Open the Chat Monitor Settings. 
2. On the main window, select Summary Report 

from the list in the top left corner of the 
window. 

3. Click Search. 
4. Choose your search options. 
5. Click Search. 
6. To view a recoding from the search results, 

select it and click View. 
 

 
 
Emailing Recordings 
You can choose to have individual recordings emailed to you as part of receiving the summary report. The file size of 
these recordings may be quite large so you can optionally choose to have the files compressed before they are sent to 
you.  
To email recordings 

1. Open the Chat Monitor Settings. 
2. On the main window, select Summary Report 

from the list in the top left corner of the 
window. 

3. Select Options. 
4. On the Summary Report Options window, 

choose an option under Email the summary 
report after it is created 

5. Click OK to close the window. 
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Filtering Keyphrases and Keywords 
Detection and Notification 

Keyword monitoring and filtering reduces your children’s risk of exposure to online predators. When a specific 
keyword or phrase is detected in a conversation, Chat Monitor immediately takes the action you have specified, if any.  
 
These actions, which can be used together in any combination, include:  

 No action; simply recording the conversation.  
 Replacing the keyword or phrase with a masking symbol, the asterisk.  For example, if the phrase "what 

r u wearing" is typed by someone chatting with your child, Chat Monitor modifies the text so all your 
child sees is "**** * * *******."  

 Sending a real-time email alert after a specified number of words or phrases are used in a conversation, 
which includes the number of times a word was used, the type of word/phrase and a list of the actual 
words and phrases used. 

 Displaying a personalized message from the administrator to the person chatting after a specified 
number of words or phrases are used in a conversation. 

 Ending the chat conversation after a specified number of words or phrases are used in a conversation 
and limiting access to chat and instant messengers after the conversation is disconnected. 

 
The Lists 
Chat Monitor includes three lists of keyphrases and keywords: High Risk, Personal Information, and Other. These lists 
are fully viewable and editable by an authorized user. Chat Monitor uses the contents of these lists when analyzing 
online conversations.  
 
High Risk Keyphrases 
Children often are engaged in conversations that parents find suspicious or indicative of a potential threat. Chat 
Monitor enables parents to decide what content within a conversation is potentially risky and notifies them in real-time 
when the risk is perceived as high. This list includes phrases of an objectionable nature, many of which could be 
described as solicitous. You can add, edit or delete any entry on the list.  This list can also be updated with additional 
entries from the Net Nanny website.   
 
Personal Information Keywords and Phrases 
Children feel safe online and often have no qualms about giving out identifying information. Chat Monitor lets you 
customize what information you want to protect. This list is empty until you add information to it such as names, 
addresses, telephone numbers, school names, team names, and financial information. You can add, edit or delete any 
entry on the list. 
 

11 
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Other Keywords and Phrases 
Many people feel totally anonymous online and chat room discussions or instant messaging conversations may quickly 
become harassing or sexual in tone. This list includes “colorful” words and phrases of an objectionable nature in 
multiple languages (English, French, Italian, German, and Spanish).  You can add, edit or delete any entry on the list. 
This list can also be updated with additional entries from the Net Nanny website. 
 
Advanced Users:  You can direct Chat Monitor to mask multiple forms of the same word by using the asterisk 
symbol as a wild card character. A wild card is a symbol that stands for one or more characters. Using wild cards as 
part of the entries on the Other list enables Chat Monitor to find multiple versions of a single keyword. The wild card 
can be placed at the beginning of the keyword (*blue), at the end of the keyword (blue*) or both (*blue*).  
 
Adding or Editing Keywords and Phrases 
To add or edit a keyword 

1. Open the Chat Monitor Settings.  
2. Select Filter Keywords in Chat 

Conversations from the list in the 
top left corner of the window. 

3. On the Filter Keywords in Chat 
Conversations window, select the 
list you want to modify by 
choosing it from the list box: 
High Risk, Personal Information, 
Other. The selected list displays. 

4. Do one of the following: 
 To add a new word or 

phrase, click Add. 
 To edit a word or phrase, 

select it and click Edit. 
5. Type the keyword or phrase. 
6. Click OK. 

 

 
 

 
 
Deleting words or phrases 
You can delete words and phrases from any of the three lists. 

To delete an entry from a list 

1. Open the Chat Monitor Settings.  
2. Select Filter Keywords in Chat 

Conversations from the list in the 
top left corner of the window. 

3. On the Filter Keywords in Chat 
Conversations window, select the 
list you want to modify by 
choosing it from the list box: 
High Risk, Personal Information, 
Other. The selected list displays. 

4. Select an item in the list and click 
Delete. 
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Updating High Risk and Other keywords from www.netnanny.com 
You can choose to add new  items to the lists of keywords by periodically downloading an updated list from the Net 
Nanny website and importing the list into Chat Monitor. The most current list update is posted in the Support section 
of the Net Nanny website. You can download the update to your desktop and then “import” it into your Chat 
Monitor program. 

To update the lists 

1. Go to www.netnanny.com. 
2. Choose Support. 
3. On the Support page, choose Chat Monitor. 
4. On the Chat Monitor page, click the link to download the list to your desktop. 
5. After the download completes, open the Chat Monitor Settings. 
6. From the File menu, choose List Update. 
7. When prompted, locate the file you downloaded on your desktop and select it. 
8. Click Open to add the file to Chat Monitor. 
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Limiting online chatting 
Controlling and blocking access 

Blocking all access  
You can choose to completely block access to one or more popular chat and instant messenger programs. Chat 
Monitor includes a pre-populated list of the chat and instant messenger programs it supports and you can choose to 
block or allow those programs. 
 
Be sure to update your software regularly to ensure you have the most current list of supported chat and instant 
messenger programs. 
 
To block access to one or more programs 

1. Open the Chat Monitor Settings 
2. Choose Allow Chat and Instant 

Messengers from the list in the 
top left corner of the window. 

3. On the Allow Chat and Instant 
Messengers list, locate the list of 
programs and select an item from 
the list. 

4. Click Block. The status of the 
program updates from allowed 
(green circle icon) to blocked (red 
x icon). 

5. Repeat for additional programs as 
needed. 
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Scheduling access 
You can create a daily or weekly schedule of time periods when persons in your home are allowed to chat online. 
Chatting is allowed during the specified times only and using only those chat or instant messenger programs you have 
chosen to be “allowed.”  Any attempts to chat outside these time limits are recorded in the system log. Additionally, 
you can choose to have Chat Monitor display a message to a person who attempts to chat when chatting is not 
allowed, reminding them of your personal values and rules. 
 
Important: The time sessions you create when chatting online is allowed, applies only to those chat and instant 
messenger programs that are allowed. 
 
 
To schedule times when chat is allowed 

1. Open the Chat Monitor Settings 
2. Choose Allow Chat and Instant Messengers 

from the list in the top left corner of the 
window. 

3. On the Allow Chat and Instant Messengers 
list, click Add, located near the bottom of the 
window. 

4. For each time session when chat is allowed, 
choose the start and end times and the day or 
days it occurs. 

5. Click OK.  
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6 
Reports 
Monitoring user activity and system activity 

Chat Monitor maintains records of chat-related activities by both users and by the software in response to those user 
actions. 
 
Summary Report 
The Summary report presents high-level information about a user’s chat activity and basic information about the 
computer where the software is installed and the software itself.  This information can provide you an indication that 
tampering has occurred, for example, the installation date of the software changes from the date you know you last 
installed it.  
 
Other related information includes the number of times a user attempted to chat when chatting was not allowed (Chat 
Session Attempts), the number of times a user attempted to change the PC’s clock (PC Date/Time Changes), and the 
number of times someone attempted to gain access to the settings by typing a password (Administrator Password 
Attempts). 
 
By default, the summary report is generated automatically following the initial installation and configuration of the 
software. You can choose the days of the week and the time of day you want the summary report generated. In 
addition you can choose to have it sent to you by email. This allows you to review its contents in privacy. 
 

To choose summary report options 

1. Open the Chat Monitor Settings 
2. Choose Summary Reports from the list in the 

top left corner of the window. 
3. On the Summary Reports window, click 

Options. 
4. Choose the options you want. 
5. Click OK. 
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System Log 
The system log records events that may indicate a software-tampering attempt has been made. It also records when an 
email has been sent from Chat Monitor to the email address you have specified and that email has failed to arrive 
successfully. It does not document changes you have made to any of the programs settings, such as list updates, 
software updates or specific options (for example email or keyword options). 
 
You can delete entries from the log manually, or have Chat Monitor delete the oldest logs after they have been kept on 
file for a specific number of days. (180 days is the default number that the logs are stored). 
 
Entries that appear in the log are: 

 PC time change. If the time on your PC has changed and you did not change it, tampering with the 
software may have occurred. 

 Password attempt. If attempts have been made to “crack” the password by repeated attempts to type 
it, it may indicate a user has attempted to gain access to the settings. 

 Password change. If the password has changed, and you did not change it, it may indicate that your 
password has been discovered and used to access the settings to change them or to delete the software. 

 Hotkey change. It the hotkey has changed and you did not change it, tampering with the software may 
have occurred. 

 Questions change. If the questions have changed and you did not change them, this may indicate 
tampering with the software has occurred. 

 Service restart. The service is one of the Chat Monitor components necessary for the software to 
work. This may indicate that an unauthorized attempt was made to delete the software. 

 Chat Monitor program started. If the program has been stopped from the system tray menu (visible 
installation only) or from within the main settings window, and re-started, this entry appears in the log. 

 Installation date. If the installation date is not the date that you installed the software on, tampering 
may have occurred. 

 Email delivery failed. If Chat Monitor has tried and failed twice to deliver email to the address you 
have specified, this entry appears in the log. 

 Chat Monitor program stopped. If the program has been stopped and you did not stop it, this may 
indicate tampering has occurred. 

 Service stopped. The service is one of the Chat Monitor components necessary for the software to 
work. This may indicate that an unauthorized attempt was made to delete the software. 

 Access attempts. If attempts have been made to access blocked chat and instant messenger programs 
repeatedly, this may indicate an attempt to circumvent the restrictions you have set up for chatting. The 
number of these entries in the log can get quite large, very rapidly. 
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To view or delete the system log 

1. Open the Chat Monitor Settings. 
2. Select the System Log from the 

list in the top left corner of the 
window. 

3. Do one or more of the following: 
 To delete an entry in the log, 

select it and click Delete. 
 To delete all entries in the log, 

select it and delete it. 
 To change how long logs are 

kept, change the number of 
days by entering a value 
between 1 and 999. 
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7 
Securing the Software 
Passwords, Hotkeys, and Stealth  

Password protected settings 
The Chat Monitor Settings are always protected by a password.  You choose the password when you first install the 
software and then you can change it at any time through the Chat Monitor Settings. 
 
Authentication Questions and the Forgotten Password 
If you forget the password, as indicated by typing it 3 times incorrectly, Chat Monitor prompts you to authenticate 
yourself as the authorized user by correctly answering the authentication questions. You can change the questions at 
any time.  
 
Important: This is recommended if you believe that your children have guessed the answers to the questions you 
selected.  
 
Changing the Password 
You can change the password at any time through the Chat Monitor Settings window. It is always recommended that 
you choose to send yourself an email to remind you of what the new password is. Be sure that it is sent to an email 
account that your children do not have access to or knowledge of.  
 

To change the password 

1. Open the Chat Monitor Settings. 
2. From the File menu, choose Change 

Password. 
3. Type your current password. 
4. Type your new password. 
5. Re-type your new password. 
6. To send yourself an email of your new 

password in case you forget it, select the 
check box. 

7. Click OK. 
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Changing the Authentication Questions 
You can change the authentication questions at any time through the Chat Monitor Settings window. It is always 
recommended that you choose to send yourself an email to remind you of what the new questions and answers are.  
 

To change the authentication questions 

1. Open the Chat Monitor 
Settings. 

2. From the File menu, select 
Change Questions. 

3. Select a question from those 
available and type your answer 
in the box. 

4. Repeat for the second question. 
5. To send yourself an email of 

your new questions in case you 
forget them, select the check 
box. 

6. Click OK. 
 
 
Anti-tampering measures 
Stealth 

Chat Monitor leaves the choice to be stealthy or not in the hands of the parent. The stealth capability of Chat Monitor 
occurs on several levels. If you choose a stealth installation and leave the software in it’s default “monitor-only” mode, 
your children will be hard pressed to learn that the software exists on the computer at all. It is difficult to know the 
software is installed when there is no visible indication of its presence.  
 
Tip: After monitoring for some period of time, you may choose to have a conversation with your children about their 
chatting activities, which promptly informs them that you have some sort of method for checking up on them.  If you 
choose to have Chat Monitor take some action in response to chat activity, an action that is visible to the person 
chatting, the software is no longer unobtrusive and transparent, thereby alerting the person chatting to it’s existence. 

Hotkey combination 

The hotkey combination provides an invisible point of access to the software resulting in additional stealth and 
additional security. You can change the hotkey combination at any time through the Chat Monitor Settings. It is always 
recommended that you choose to send yourself an email to remind you of what the combination is. Be sure that it is 
sent to an email account that your children do not have access to or knowledge of. 
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To change the hotkey combination 

1. Open the Chat Monitor Settings 
2. From the File menu, choose Change 

Hotkey. 
3. Type a different number or character. 
4. To send yourself an email with the new 

hotkey in case you forget, select the 
check box. 

5. Click OK. 
 
 

Atomic Clock Synchronization 

The purpose of synchronizing your PC’s clock with an atomic clock is to thwart those technically savvy users who 
want to get around the access control capability of Chat Monitor, specifically the time limit schedule.  You set the initial 
time zone settings when you install the software. Every time a chat or instant messenger conversation starts on your 
PC, Chat Monitor synchronizes with an atomic clock. You can turn this feature off and on at any time. 
 
If you move to a different time zone, you must change the time through the Chat Monitor Settings as well as the 
Windows desktop.  
 

To turn off or on time synchronization 

1. Open the Chat Monitor Settings 
2. From the File menu, choose 

Change Time Zone. 
3. Clear the check box. 
4. Click OK. 

 

To change your time zone 

1. Open the Chat Monitor 
Settings. 

2. From the File menu, choose 
Change Time Zone. 

3. Select another time zone from 
the list box. 

4. Click OK. 
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8 
Keeping Current 
Updating the Software, Keyword Lists, and Email 

Software Updates 
Chat Monitor depends on current information to keep up with new chat and instant messengers programs that 
become available and accessible to your children. Using your Internet connection, you can keep your software updated 
with support for the latest chat programs as well as any defect fixes or other minor software improvements. Your 
normal Internet access charges apply when you update the software using Chat Monitor’s update wizard.  
 
The update wizard automates the process of obtaining and installing program updates. It locates and obtains files from 
an Internet site and installs them. When you installed the program, you were prompted to check for software updates. 
If you chose to not do so, it is recommended that you check for software updates as soon after you install the software 
as possible. After installation, you will want to check for updates regularly. 
 

To update the software 

Important: Updating the Chat Monitor requires a restart of your computer. 
 

1. Open the Chat Monitor Settings. 
2. From the File menu, choose Update Software. 
3. Follow the instructions. The process finishes with a restart of your computer. 

 
 
List Updates 
You can periodically update the list of pre-populated keywords (High Risk and Other) used by Chat Monitor for 
filtering content in chat conversations by importing an updated list from the Chat Monitor website 
(www.netnanny.com).  This is in addition to any new entries you add to the lists yourself.  
 
To update the lists 

1. Go to www.netnanny.com. 
2. Choose Support. 
3. On the Support page, choose Chat Monitor. 
4. On the Chat Monitor page, click the link to download the list to your desktop. 
5. After the download completes, open the Chat Monitor Settings. 
6. From the File menu, choose List Update. 
7. When prompted, located the file you downloaded on your desktop and select it. 
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Email Settings 
You can ensure uninterrupted delivery of email reports from Chat Monitor by updating your email settings promptly 
whenever your email changes or if you decide to have Chat Monitor send reports to a different email account. 
 
Tip: Do not use the email server authentication options (Account Name and Password) unless required to do so by 
your email provider. 
 
 
To update your email settings 

1. Open Chat Monitor Settings. 
2. From the File menu choose 

Change Email Settings. 
3. Make the necessary changes, 

being sure to correctly specify 
the SMTP server for your 
email provider. 

4. To send yourself a test 
message, click Test Email. 
This is highly recommended. 

5. Click OK. 
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